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Microsoft office - 

It is the group of applications, it is used to edit, cut format and print the part of the file and 

text based document as well as making lazers and presentation using spread sheet and 

presentation programs and data base handling and manipulating of records is done through 

ms access like relational data base management system and other group of applications are 

also used according to the users choice. 
  

Ms Word 
word processing is recognized as text based formatting, editing and printing, ms word 

provide the feature of creating the letter, application, invoice and publication related 

materials like book- composing designing, page layout making table and off-course the use 

of mail merge make it powerful by creating one letter and generate it’s copy to different 

people in different places by the help of table like other application of ms word. It has 

common menu and tools are available. It is opened by the program file name windows 

.Exe; the extension of ms word file is .doc. 

 
 

How to start ms word:- 

 Click on start menu (Task bar) 

 Select all programs option 

 Click on Microsoft office 

 And select ms word or 

 Click on start menu 

 Select run option 

 Type winword into the dialog box and 

 Click on ok button 
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THE MS-WORD WINDOW 

 

 

 
ELEMENT OF MS – WORD WINDOW 
 

Title bar: The title bar displays the name if the currently active word 

document. It also holds same control buttons- minimize, 

restore/maximize and close. 

Quick Access toolbar: This tool bar is located at the top of window. By 

default, this toolbar display the save, undo and Repeat buttons. We can also add 

other option in this toolbar. 

Ribbon: Ribbon is displayed just below the title bar. In ribbon 

commands are organized in logical groups, which are collected together under 

tabs. You can hide/show ribbon by double clicking the active tab . 
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ELEMENT OF MS – WORD WINDOW(CONT.) 
 

Tab: Tab is just like which menu that contains the set of tools (option) 

the main difference is tab contains all tools in icon format that make easy to access the 

tool. 

Ms-Word 2010 by default contains 8 tabs namely: 

File, Home, Insert, Page Layout, Reference, mailing, review and View. 

Scroll bar: The scroll bar helps you scroll the content or body of 

document. 

Workspace: The workspace is the area in the document window where 

you type the text of your document. 

Ruler: Showing page width and position of tab, indents columns and margins. 

Status bar: The status bar displays information about the currently 

active document. This includes the page number that you are working, the 

column and line of the cursor position and so on. 

 

CREATING NEW BLANK DOCUMENT 

When you run ms-word, it opens a new blank document and default name is 

Document1. 

Steps: 

Click the File tab and then click New or Press (Ctrl+N) or Choose New 

option from quick access toolbar. 

Under Available Templates, click Blank Document. Click 

Create. 

CREATING NEW DOCUMENT USING TEMPLATES 

Word 2010 allows you to apply built-in templates from a wide 

selection of popular Word templates, including resumes, agendas, business 

cards, and faxes. 

Steps : 

On the File tab, click New or press (Ctrl+N) 

Under Available Templates, do one of the following: To 

use one of the built-in templates, click Sample 

Templates, click the template that you want, and then click Create. 
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OPENING AN EXISTING DOCUMENT 
 

Open Option allows you to open an existing word document from either 

     the hard disk or other media attached to the computer. 

Steps: 

Click the File tab, and then click Open or Press (Ctrl+O). 

In the left pane of the Open dialog box, click the drive or folder that contains the 

document. 

In the right pane of the Open dialog box, open the folder that contains the 

document that you want. 

Click the document and then click Open. 

 
SAVING A DOCUMENT 

 

The first time you save a Word document, you have to assign a name and 

choose the folder in which to save it. 

Steps: 

Click on File tab and choose save option or Press (Ctrl+S) or Click save 

button on Quick Access toolbar 

Then Save As dialog box will appear (if you are saving file first time) 

Specify the file name & location 

Click on save button 

SAVE A DOCUMENT WITH NEW FILE (DOC.) 

Save as allows you to save the current document under a new file it also 

allow to save the document with different format and version of MS-word like ms-

word old version and html format etc. 

Steps: 

Click on file Tab and choose Save As option or Press (F12) Then 

Save As dialog box will appear 

Specify the New file name and chose format from save as drop down list 

Click on save button. 
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CLOSING A DOCUMENT 
 

When you want to close the current document without closing the 

application you can choose close option. 

Steps: 

Click on file tab and choose Option or Press (Ctrl+W) 

If the file is not saved before the close operation, ms-word display a dialog 

box confirming the saving of file. 

EXIT FROM MS-WORD 
 

Exit (Alt+F4): Exit option allows you to quit MS-Word Application. 

Steps: 

Click on file tab and choose Exit ms-word option or Press Alt+F4 or Click 

on close button on title bar . 

If the file is not saved before the close operation, ms-word display 

a dialog box confirming the saving of file. 

UNDO AND REPEAT ACTION 
 

Undo option allows to cancel or remove the last changes taken place in the 

document such as editing, formatting etc. 

Steps: 

Click on undo button from quick access toolbar or pres (Ctrl+Z) from 

keyboard. 

Repeat option allows to repeat the last changes that canceled by undo 

operation. 

Steps: 

Click on repeat Button from Quick access toolbar or Press (Ctrl+Y) from 

keyboard. 

MOVING TEXT OR GRAPHIC OBJECTS 
 

Ms-word Allows to move text or any graphics object from one location to 

another location in same document or another document also. 

Steps: 

Select the text or graphic object which you want to move. 
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Click on Cut button from clipboard group on home tab or Press 

(Ctrl+X) or Select cut option from popup menu by clicking right mouse 

button. 

Place the cursor where you want to place the text or graphic object. 

Click on paste button from clipboard group on home tab . Or 

press (Ctrl+V) or Choose paste option from popup menu by 

clicking the right mouse button. 

COPYING TEXT OR GRAPHIC OBJECTS 
 

Ms-word allows to copy selected text and graphics from your document 

and keep it available for pasting it later. This command is available only when you 

select text and graphics. 

Steps: 

Select the text or graphic object which you want to copy. 

Click on Copy button from clipboard group on home tab or Press 

(Ctrl+C) or Select copy option from popup menu by clicking right mouse 

button. 

Place the cursor where you want to place the text or graphic object. 

Click on paste button from clipboard group on home tab . Or press 

(Ctrl+V) or Choose paste option from popup menu by clicking the right 

mouse button. 

 
FORMATTING TEXT 

 

The Font Group allows you to change your text font style, size, color and 

many other elements. 

Steps: 

Select the text which you want to format 

Choose the font name, font-size or color which required Font 

Family 

Increase/Decrease Font Size 

Text Color 

Bold/Italic/Underline/Strikethrough/Superscript/Subscript Change 

Textcase 
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Remove formatting 

Highlight Text 

 
CHANGE TEXT CASE 

 

You can change the case of selected text in a document by clicking a single 

button called Change Case on the ribbon. 

Following cases are available in ms word 

Sentence case 

UPPERCASE 

lowercase 

Capitalize Each Word 

tOGGLE cASE 

(Shift+f3) Key used to switch from lowercase to upper and capitalize each 

word its work wise versa . 

 
FORMATTING PARAGRAPH 

Paragraph Group allows you to change your paragraph alignment, line spacing, 

paragraph spacing, text indent and many other elements. 

Steps: 

Select or place the cursor on paragraph in which you want to perform the 

formatting 

Choose required option from paragraph group on home tab. 

 
TEXT ALIGNMENT 

The attribute alignment of a paragraph refers to the position of the document 

text on the page. 

Step: 

Select the line of text which alignment you want to change 

Select the required alignment button from paragraph group on home tab. 

Left Alignment Ctrl + L Right 

Alignment Ctrl + R Centre 

Alignment Ctrl + E Justified 

Alignment Ctrl + J 
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BULLETS AND NUMBERING: 
 

Bullets and numbering basically used for making a list or arranging 

the contents in order. You have many choices in number and bullets as well. 

Steps: 

Select the line of text which u want to convert in list or place the curser before type your 

list. 

Select the bullet or number style which required , from paragraph group on 

home tab. 

We can also create nested list means list inside the list by using increase 

and decrease list level button. 

LINE AND PARAGRAPH SPACING 

In ms-word document we can increase decrease the space between two lines. 

Step: 

Select the paragraph you want to format. 

Click on line spacing drop down arrow on paragraph group from home 

tab. 

Select the line spacing from the list. 

    Set line-spacing to single-space Ctrl + 1 Set 

line-spacing to double-space Ctrl + 2 Set line-

spacing to 1.5 Ctrl + 5 

Add or remove one line space preceding a 

paragraph 

Ctrl + 0 

 
PARAGRAPH INDENT 

 
Left indent ctrl + M 

Remove left indent ctrl + shift + M 

Hanging indent ctrl + T 

Remove hanging indent ctrl + shift + T 

Indents : sometime you want to start a particular line a little away from the left 

margin. You may also want the line to end a little before the right margin. This 

process of pressing the text in, away from the left and right margin is called 

indenting. 

Steps: 
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• Click on paragraph launcher icon ,then paragraph dialog box will display. 

• From the indentation group specify the value and click on ok button. 

 

TAB SETTING 

Tab stops are used to write text in a tabular form. In ms word a tab 

stop is by default set at 0.5 inch. Once it is set you can go one tabstop to 

another by pressing the tab key. 

Step: 

Click on paragraph dialog box launcher icon on paragraph group 

from home tab. 

Click on Tabs button .., Tabs dialog box will display. 

In the tab stop position box, type the position for a new tab. 

To align tabstop, select Left, Center, Right, Decimal, Bar as required 

from the Alignment section. 

Click on set button. 

. 

 
FIND TEXT 

This feature of ms-word helps you to locate a specific text or phrase of a 

maximum size of 255 characters. You can also search for special characters such as tabs, 

page breaks, extra spaces, line break etc. within a document. 

Steps: 

Click on find button from editing group of home tab or press Ctrl+F The find 

and replace dialog box will display 

Type the text on find what dialog box and press Find Next button. Some 

other option also available in search: 

Match Case matches the text exactly as you have typed it Find whole words 

only Finds complete words only. 

Will cards Use special search operations. W?? , Win* Sound 

like Matches words that sound alike such as Seize & Sees 

Format Which include font, paragraph, tab style. 
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REPLACE TEXT 

Ms-Word also allows you to replace a text by another text throughout in 

the document, for example, to replace an incorrect spelling by a correct spelling. 

Steps: 

Enter the text to be found in the find what: box. Enter 

the new text in the replace with box. 

Click on the replace button or replace button. 

 
WORKING WITH TABLE 

A table contains information arranged in rows and columns. 

Arranging text in tabular form makes the text look neat and 

organized. A table is made up of rows and columns that you can fill with text 

and graphics. The first row contains headings for each of the columns. Each 

heading is referred to as a field name. 

There are three way to create table By 

draw table option 

By insert option By 

design wizard 

Basic operations in table 

Insert rows/column/cell 

Delete cells 

Merge cell 

Split cell 

Table formatting 

 
WORKING WITH IMAGE, SHAPE AND GRAPH 

Ms word enable to insert or create different drawing objects and image in 

document 

Following option available to work with drawing objects Insert 

picture form system 

Insert picture from Clip Art 

Create Shapes 
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Insert Smart Art Object 

Insert Chart 

HYPERLINK 

This option allows you to link a text or image from website, file, email 

or any bookmark by which you can quickly jump to a specific file or 

location. 

Steps: 

Select the text or graphic object which you want to link 

Click on hyperlink button on links group from insert tab or press Ctrl +K 

then hyperlink dialog box will display. 

Select one option under link to: 

Existing file or Webpage 

Place in this document 

Create a new Document 

Email address 

Specify the path or link under link in: 

Click on ok button 

Remove hyperlink 

Right-click the hyperlink you want to remove, and then click Remove 

Hyperlink. 

WORKING WITH HEADER AND FOOTER 

A header is a text or graphic that is automatically printed at the top of every page 

and footer is a text or graphic that is automatically printed 

at the bottom of every page. The advantage of using header and footer is that 

you have to create them only once and they automatically appear on each page. 

Step: 

Click on header or footer button from header footer on Insert Tab Chose Header 

Edit /Footer Edit option 

Type your text or insert image /logo etc, 

You can also insert auto text like Date & Time , Page Number. Click on 

Close Header and Footer button from Current Tab. 
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DROP CAPS 

A drop cap is a large letter that begins a paragraph and drops 

through several lines of text .There are two option for setting Drop Caps as 

following: 

Dropped 

In Margin 

Step: 

Place the cursor within the paragraph whose first letter will be dropped. 

Choose the Drop caps option from Insert Tab, the Drop Caps dialog box will 

display. 

Select the drop Style and set the number of line to drop and distance 

from text. 

Click on ok Button. 

 
WATERMARKS 

Watermarks refer to very light text or graphics behind the text of a document. 

It is often used by companies to add the logo to 

documents. Sometimes the status of a document, such as for review only, 

confidential, or draft is used as watermark text 

Steps 

Click Watermark button from the Page Background group on the Page 

Layout tab. 

Select text from list or click on Custom Watermark option. 

Specify your watermark picture or text and click on apply button the click 

on Ok button. 

COLUMNS 

Multiple columns make a document more appaling and it is 

requirement of the document as the case of newspapers and 

magazines where texts appear in multiple columns. 

Step: 

Select the list of paragraph text which you want to convert in multiple 

paragraph. 

Click on column option from page setup group on Page Layout Tab. 
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Specify the Number of column and width of each column. 

If you want line between each column the select line between checkbox. 

Click on ok Button. 

 
PAGE SETUP 

This command allows you to sets the margins, paper source, paper size, page 

orientation and layout options for the active file. 

Margin 

This option allow to set the space on top, bottom, left and right of document . 

Orientation 

This option help to change the page orientation from portrait to 

landscape and vice versa. 

Paper size 

This option allows to change the page size of current document . 

The default page setting is letter and the common page size are , 

A4,A5 , Legal and Letter. 

Step: 

Click on Page setup launcher icon from page setup group on page layout tab, the 

page setup dialog box will display. 

Specify the paper margin, page orientation and page size. Click on 

ok button. 

MAIL MERGE 

Mail Merge is a useful tool that allows you to produce multiple letters, 

labels, envelopes, name tags, and more using information stored in a list, 

database, or spreadsheet. When performing a Mail Merge, you will need a 

Word document (you can start with an existing one or create a new one) and a 

recipient list, which is typically an Access Database. 

Steps: Creating Main Document 

Open an existing Word document, or create a new one. 

From the Mailings tab, click the Start Mail Merge command 

and select Step by Step Mail Merge Wizard from the drop-down menu. 

Select Letter radio button in the “Select document type” 

section. 
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A 

Click on “Next: Starting document” to display the next wizard. Select 

“use the current document” radio button. 

Click on “Next: Select recipients” to display the next wizard. 

 
MAIL MERGE (CONT.) 

Step : Creating a data source: 

Select “Type a new list” radio button under “select recipients” section. 

Click on “create…” under “type new list” section. new 

address list dialog box appears on the screen. 

Click on custom button for customize the fields. The 

customize address dialog box appears. 

Select the field from the field names list box, which you want to remove and click 

on delete button. 

If you want to add new field click on Add button. Type the field name and click 

on ok button. 

Finally click on ok button to close the customize address list dialog box. Type the 

field values and click on new entry button to add new record. Click on close 

button. 

Type the file name in the file name text box and click on save button. The 

“Mail merge recipients” data source dialog box will be displayed. Click on ok 

button 

MAIL MERGE (CONT.) 

Step : insert merge field in the main document 

Place the cursor where you want to insert field. 

To insert a merge field, click the insert merge field button on the mail 

merge toolbar. 

The insert merge field dialog box will be displayed. Select 

the field name and click on insert button. 

Click on close button. 

Creating the merge document: 
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Select merge to new document button from the mail merge tool bar. Select 

All button in the “merge to new document” dialog box. 

Click on ok button. 

 
SPELLING AND GRAMMAR 

Word has a spelling and grammar checker that can help you draft 

your documents error free. It also provide suggestion list by which we can 

select the suggestion to correct the spelling and grammar mistake. All 

spelling mistake display with red color under line and grammar mistake with 

green color underline. 

Step: 

Click on spelling & grammar option from proofing tab on Review Tab or Press 

F7 Key. 

Then spelling & Grammar dialog box will display. 

Choose the correct spelling from suggestion list and click on change button or 

click on ignore if you don’t want to change.      


